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Legal Information
The information provided in this document contains general descriptions, technical
characteristics and/or recommendations related to products/solutions.

This document is not intended as a substitute for a detailed study or operational and
site-specific development or schematic plan. It is not to be used for determining
suitability or reliability of the products/solutions for specific user applications. It is the
duty of any such user to perform or have any professional expert of its choice
(integrator, specifier or the like) perform the appropriate and comprehensive risk
analysis, evaluation and testing of the products/solutions with respect to the relevant
specific application or use thereof.

The Schneider Electric brand and any trademarks of Schneider Electric SE and its
subsidiaries referred to in this document are the property of Schneider Electric SE or
its subsidiaries. All other brands may be trademarks of their respective owner.

This document and its content are protected under applicable copyright laws and
provided for informative use only. No part of this document may be reproduced or
transmitted in any form or by any means (electronic, mechanical, photocopying,
recording, or otherwise), for any purpose, without the prior written permission of
Schneider Electric.

Schneider Electric does not grant any right or license for commercial use of the
document or its content, except for a non-exclusive and personal license to consult it
on an "as is" basis.

Schneider Electric reserves the right to make changes or updates with respect to or in
the content of this document or the format thereof, at any time without notice.

To the extent permitted by applicable law, no responsibility or liability is
assumed by Schneider Electric and its subsidiaries for any errors or omissions
in the informational content of this document, as well as any non-intended use
or misuse of the content thereof.
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Safety Information

Important Information
Read these instructions carefully and look at the equipment to become familiar
with the device before trying to install, operate, service or maintain it. The
following special messages may appear throughout this manual or on the
equipment to warn of potential hazards or to call attention to information that
clarifies or simplifies a procedure.

The addition of this symbol to a "Danger" or "Warning" safety label indicates that an
electrical hazard exists which will result in death or serious injury if the instructions
are not followed.

This is the safety alert symbol. It is used to alert you to potential personal injury
hazards. Obey all safety messages that follow this symbol to avoid possible injury or
death.

DANGER
DANGER indicates a hazardous situation which, if not avoided, will result in
death or serious injury.

Failure to follow these instructions will result in death or serious injury.

WARNING
WARNING indicates a hazardous situation which, if not avoided, could result
in death or serious injury.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

CAUTION
CAUTION indicates a potentially hazardous situation which, if not avoided,
could result inminor or moderate injury, or equipment damage.

Failure to follow these instructions can result in injury or equipment
damage.

NOTICE
NOTICE is used to address practices not related to physical injury.

Failure to follow these instructions can result in equipment damage.

Please Note
Electrical equipment should be installed, operated, serviced, and maintained only
by qualified personnel. No responsibility is assumed by Schneider Electric for any
consequences arising out of the use of this material.

A qualified person is one who has skills and knowledge related to the construction,
installation, and operation of electrical equipment and has received safety training
to recognize and avoid the hazards involved.
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Safety Precautions
During installation or use of this software, pay attention to all safety messages that
occur in the software and that are included in the documentation. The following
safety messages apply to this software in its entirety.

WARNING
LOSS OF PROTECTIVE FUNCTION DURING SETTING CHANGES
• Following a setting change, the relay could reboot and equipment protection

is unavailable. Ensure all operators are outside the arc flash boundary
during device reboot.

• Use appropriate personal protection equipment (PPE) while making setting
changes within the arc flash boundary.

• Do not approach the equipment until the device reboot is complete.
Failure to follow these instructions can result in death, serious injury, or
equipment damage.

WARNING
UNINTENDED EQUIPMENT OPERATION
• Do not use the software and associated devices for critical control or

protection applications where human or equipment safety relies on the
operation of the control circuit.

• Do not use the software and associated devices to control remote equipment
without proper access control and status feedback.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

WARNING
INACCURATE DATA RESULTS
• Do not incorrectly configure the software and its associated devices.
• Do not rely solely on software messages and reports to determine if the

software and its associated device are functioning correctly or meeting all
applicable standards and requirements.

• Do not use reports or data results as substitutes for proper workplace
practices or equipment maintenance; they are supplemental only.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.
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Overview
This manual offers a comprehensive introduction to the features of the
PowerLogic™ Engineering Suite common functions across devices. It guides you
through the installation process, provides a quick start introduction, and explains
how to manage projects, sites, and devices. Additionally, it covers information on
logging functions.

This manual does not cover device configuration. For detailed instructions on
configuring your devices, refer to the corresponding device user manual or
configuration guide.

Introduction
The PowerLogic™ Engineering Suite is organized around projects, containing
sites, themselves containing devices.

Use the PowerLogic™ Engineering Suite to build a list of devices and organize
them in the same manner as they physically exist in a system (collection of
interconnected IEDs through communication networks). Create and upload setting
parameters for each device and use the PowerLogic™ Engineering Suite to
supervise the devices directly.

Purpose of this manual
This User Manual is intended for electrical power engineering experts, system
integrators, experienced users, communication specialists, or other qualified
personnel who are responsible for installing, configuring, maintaining, and using
the PowerLogic™ Engineering Suite software.

This manual is not a tutorial, it was created with the assumption that you have
been trained in the use and configuration of PowerLogic™ Engineering Suite.

NOTE: This manual does not discuss the detailed settings configuration and
safety precautions of supported devices. Refer to the specific device User
Manual for detailed information.

Workflow
The following figure shows the main workflow for two types of users: new users
and experienced users.

The workflow can help provide a quick reference before you use the
PowerLogic™ Engineering Suite.
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Supported devices
Use the PowerLogic™ Engineering Suite to configure the following devices:

• PowerLogic™ P7 protection and control devices
• PowerLogic™ P3X60 protection and control devices
NOTE: To get specific configuration instructions for the supported devices,
refer to the user manual or configuration guide that comes with the device.

Software user manual version
This user manual pertains to PowerLogic™ Engineering Suite 2024 in the latest
release.
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Cybersecurity
This chapter contains information about PowerLogic™ Engineering Suite’s
cybersecurity. Network administrators, system integrators, and personnel that
commission, operate, maintain, or decommission this application should review
Recommended actions, page 12 section to help secure your PowerLogic™

Engineering Suite in a protected environment.

WARNING
POTENTIAL COMPROMISE OF SYSTEM AVAILABILITY, INTEGRITY, AND
CONFIDENTIALITY
• Change default passwords to help prevent unauthorized access to device

settings and information.
• Disable unused ports/services and default accounts, where possible, to

minimize pathways for malicious attacks.
• Place networked devices behind multiple layers of cyber defenses (such as

firewalls, network segmentation, and network intrusion detection and
protection).

• Use cybersecurity best practices (for example: least privilege, separation of
duties) to help prevent unauthorized exposure, loss, modification of data and
logs, interruption of services, or unintended operation.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Recommended actions
Your PowerLogic™ Engineering Suite is designed to be used in a protected
environment that uses a defense in depth strategy, in compliance with IEC 62443,
the global standard for industrial automation control system security.

To help secure PowerLogic™ Engineering Suite, you must take specific actions at
every stage of the project life-cycle.

NOTE: The list of recommended actions below is not a complete list of
possible cybersecurity measures. It is meant to be a starting point to improve
the security of the PowerLogic™ Engineering Suite in a protected environment.
Consult with cybersecurity experts to plan, configure, operate, maintain, and
decommission your PowerLogic™ Engineering Suite based on your needs.

The following table lists the actions we recommend you take to help secure your
PowerLogic™ Engineering Suite in a protected environment, organized by life-
cycle stage:

Recommended action Defense-in-depth role

Plan

Review cybersecurity awareness,
page 14

Resources to increase your cybersecurity knowledge and
awareness.

Review the system defense in
depth, page 14

Understand the security measures expected to be provided
by the external environment in which the PowerLogic™

Engineering Suite is to be used.

Review the security capabilities of
PowerLogic™ Engineering Suite,
page 15

Understand how the PowerLogic™ Engineering Suite's
security capabilities can be used in a protected environment.

Review the security risks and
mitigation strategies, page 16

Known security risks and the mitigation strategies to help
minimize the risks.

Configure

Change the default password, page
16

Help reduce unauthorized access. Default account settings
are often the source of unauthorized access by malicious
users.
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Recommended action Defense-in-depth role

Limit user access, page 16 Limit user access to the minimum, least privilege level of
access needed to perform their job functions.

Revoke user privileges when no longer needed due to role
change, transfer, or termination.

Create new user and password,
page 17

Create strong passwords for each user that requires access
to the PowerLogic™ Engineering Suite.

Disable a user, page 18 Revoke user privileges when no longer needed due to role
change, transfer, or termination.

Disable unused protocols and
change default port numbers

Disable unnecessary and unused communication protocols
ports, such as SFTP and network ports, to reduce the
product attack surface.

Operate

Monitor operation logs, page 20 Monitor event logs for suspicious activity and to help identify
the cause of cybersecurity breaches that could lead to a
cybersecurity incident.

Report a cybersecurity incident or
vulnerability, page 20

Report suspicious activity, a cybersecurity incident, or a
vulnerability to Schneider Electric.

Maintain

Application data backup, page 20 Periodically backup the application data as per your
company’s policies by using professional backup software.

Keep the PowerLogic™ Engineering
Suite up to date

Keep your PowerLogic™ Engineering Suite up to date helps
protect you from security vulnerabilities.

Review user accounts on a regular
basis

Limit user access to the minimum, least privilege level of
access needed to perform their job functions.

Revoke user privileges when no longer needed due to role
change, transfer, or termination.

Keep your network security up to
date

Help reduce your attack surface, decreasing the likelihood of
a vulnerability.

Perform security audits Help verify the security status of your system.

Decommission

Record decommissioning activities Document disposal actions according to your company’s
policies and standards to keep a record of activities.

Decommission-related rules and
records

Follow decommission tasks as described by your
organization or contact your network administrator.

Decommission network and security rules. For example, a
firewall rule that could be used to get past the firewall.

Clean-up user’s application
artefacts

Help prevent the potential disclosure of data.

Wipe the application, page 21 Follow local disposal regulations.

Use a security tool to completely
remove data, page 21

Help erase all the sensitive data from your hard drive.

Plan
Before you install your PowerLogic™ Engineering Suite, use the following planning
information to help you prepare for the installation and commissioning of the
PowerLogic™ Engineering Suite in your facility.

• Cybersecurity awareness, page 14
• System defense-in-depth, page 14
• Security capabilities of the PowerLogic™ Engineering Suite, page 15
• Security risks and mitigation strategies, page 16
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Cybersecurity awareness
Knowledge is the first step to help prevent cyber intrusions. Review the following
to increase your cybersecurity awareness:

• Cybersecurity Best Practices guide

Subscribe to Schneider Electric security notifications
Register for Schneider Electric security notifications on the Schneider Electric
Cybersecurity Support Portal website.

System defense in depth
In the defense in depth approach, Schneider Electric is promoting cybersecurity
capabilities for people, process and technologies.

Only user with the right level of privilege on underlying system can do
administrative task, as a consequence hardening of the host machine is
mandatory and recommendation are provided in the following user
documentation.

This interface is accessible within the machine boundary.

ID Layer name Responsibilities to each layer of defense

L1 Layer 01: system hardening Typical application usage within system context
• Zone and Levels usage of the application

L2 Layer 02: Operating system
hardening

Windows OS Hardening:
• user account restriction
• disabling unused services (protocols, ports, …)
• patch management

For more details, refer to PowerLogic™ Engineering
Suite Hardening Guide.

L3 Layer 03: Schneider Electric
software integrity

Application package
• Setup, executable and libraries are signed using

Schneider Electric trusted certificate

L4 Layer 04: Schneider Electric
software Hardening

Files and folders permission
• Binary application folders with limited access

permission (program files)
• User’s data folder with restricted access

permission (program data)
• Application upgrade for vulnerability fixing

For more details, refer to PowerLogic™ Engineering
Suite Hardening Guide.

NOTE:
• Each layer provides additional defense mechanisms
• Each layer may be compromised; therefore, secure design principles are

applied to each layer
• The objective is to reduce the attack surface of the subsequent layers
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Potential risks and compensating controls
Address potential risks using these compensating controls:

Area Issue Risk Compensating
controls

User accounts Default account
settings are often the
source of
unauthorized access
by malicious users.

If you do not change
the default password,
unauthorized access
can occur.

Change the default
password to help
reduce unauthorized
access. See Change
the default password,
page 16 section.

Unsecured protocols Not applicable Not applicable Not applicable

Security capabilities of PowerLogic™ Engineering Suite
The PowerLogic™ Engineering Suite includes security capabilities that, when
combined with other defense-in-depth measures, can help reduce vulnerabilities.

Before you install the application, carefully review the following device security
capabilities to understand how you can configure and securely use the product in
a protected environment.

Secure area Application security capabilities Defense-in-depth role

Information
confidentiality

The application is promoting standard secured
protocol to communicate with the device, such as
HTTPS, SSH.

Secure protocols employ cryptographic algorithms, key
sizes, and mechanisms to help prevent unauthorized
users from reading information in transit.

Access Least privilege in multiple dimensions: create, read,
update and delete device configuration(s) and
security management configuration.

User account lockout limits the number of
unsuccessful login attempts.

Password strength feedback.

Use control restricts allowed actions to the
authorized use of the control system.

Application administrator can override user
authorizations by deleting user accounts.

The parameter settings of the application are
stored in protected files and folders with
administrator rights privilege.

These capabilities help enforce authorizations assigned
to users, segregation of duties, and least privilege.

Machine hardening Least functionality.

Unused protocols can be disabled to reduce the
attack surface of the machine.

Limit the number of consecutive failed login
attempts.

The default inactivity timeout is 15 minutes in
PowerLogic™ Engineering Suite application. To
unlock the session, you must enter the login
credentials.

These capabilities help prohibit and restrict the use of
unnecessary functions, ports, protocols, and services.

PLES/EN M/15A 15
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Security risks and mitigation strategies
Address potential risks using these compensating controls:

Issue Security risk Mitigation strategies

User accounts

Default account settings
are often the source of
unauthorized access by
malicious users.

If you do not change the
default password,
unauthorized access can
occur.

Application administration account must be
changed following the first launch and
login.

Change the default password for the other
users helps reduce unauthorized access.

Configure
This section contains detailed information on the following tasks:

• Limiting user access, page 16
• Changing the default password, page 16
• Creating new user and password, page 17
• Changing the password, page 17
• Disabling a user, page 18
• Enabling a user, page 18

Limiting user access
In addition to the secure machine access provided by the operating system's user
management, PowerLogic™ Engineering Suite also limits access and usage of the
application through Role-based Access Control (RBAC).

Role Description

Operator This role allows for the ability to see all information without being able to make
changes to projects, devices, or configurations. Additionally, this role is able to
connect to devices through network or USB, but is unable to change any
parameters, only able to monitor data, use live data features, and access DR
and Logs, etc.

Engineer This role allows for the ability to execute all necessary actions to configure,
commission, and test the device; however, it does not include the Installer
role's capabilities.

Installer This role allows for the ability to do all included firmware upgrades or
downgrade.

Application
administrator

This role is mainly used to create or manage the user’s account within the
application.

Changing the default password

WARNING
POTENTIAL COMPROMISE OF SYSTEM AVAILABILITY, INTEGRITY, AND
CONFIDENTIALITY

Change default passwords to help prevent unauthorized access to device
settings and information.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.
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Default username and password is:
• username: ApplicationAdmin
• password: AAAAAAAA

The password must be changed during the first login, it is recommended to store
password within a safety location.

It is also strongly recommended to keep “ApplicationAdmin” account as a safe
backup account and create another “Administrator” account to be used when
required.

To change the default password:
1. Open the PowerLogic™ Engineering Suite application.
2. Enter your username and default password for the first time, click LOGIN.
3. According to the system prompts, enter and confirm the new password.

NOTE: A password must have at least 8 characters and contain at least
one character from each of the following:

• uppercase letters
• lowercase letters
• numbers
• special characters.

4. Click Save.

Creating new user and password
Only the Application administrator role can create a new user and password.

1. Open drop-down menu by selecting user identity.

2. Click User management.

3. On the lower-left corner of User management interface, click Add new user.

4. In the User Profile area, complete all required fields and options.

5. In the Authentication area, enter the username, and then enter and confirm
the password.

6. Click Save All.

Changing the password
Only the Application administrator role can change the password.

1. Open drop-down menu by selecting user identity.

PLES/EN M/15A 17
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2. Click User management.

3. Select the required user from the user list on the User management
interface.

4. In the Authentication area, enter and confirm the new password.

5. Click Save All.

Disabling a user
Only the Application administrator role can disable a user.

1. Open drop-down menu by selecting user identity.

2. Click User management.

3. Select the required user from the user list on the User management
interface.

4. Click the icon on the right of selected username.

5. Select Disable user.

Enabling a user
Only the Application administrator role can enable a user.

1. Open drop-down menu by selecting user identity.
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2. Click User management.

3. Select the required user from the user list on the User management
interface.

4. Click the icon on the right of selected username.

5. Select Enable user.

Deleting a user
Only the Application administrator role can delete a user.

1. Open drop-down menu by selecting user identity.

2. Click User management.

3. Select the required user from the user list on the User management
interface.

4. Click the icon on the right of selected username.

5. Select Delete user.

6. Click Yes to confirm your operation.
This user is removed from the user list.

Operate
Review the following recommended actions to operate the PowerLogic™

Engineering Suite in a protected environment:
• Monitor operation logs, page 20
• Report a security incident or vulnerability, page 20
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Monitor operation logs
The PowerLogic™ Engineering Suite monitors the user’s activity by using the log
files.

Two kinds of log are continuously recorded during the user’s activity:
• A technical log file is created during the first launch of the day to collect

internal information sequence of processing
◦ Storage location: C:\ProgramData\Schneider Electric\PowerLogic

Engineering Suite\logs
• User’s activity log files are created on daily basis and contain log for user’s

action on project artefacts
◦ Storage location: C:\ProgramData\Schneider Electric\PowerLogic

Engineering Suite\project-logs

Report a security incident or vulnerability
To report suspicious activity or a cybersecurity incident, go to the Schneider
Electric Report an Incident website.

To report a security vulnerability affecting your product or solution, go to the
Schneider Electric Report a Vulnerability website.

Maintain
This section contains information on the tasks you should perform periodically to
help maintain the security of the PowerLogic™ Engineering Suite in a protected
environment.

Application data backup
It is recommended to periodically backup the application data as per your
company’s policies by using professional backup software.

NOTE: The application data is stored in the default location C:\ProgramData
\Schneider Electric\PowerLogic Engineering Suite.

The backup object including:
• Projects database of the application
• Security database of user management
• Device log artefacts

Accommodate the backup periodicity to the criticality of the data as per the device
engineering stage, for example:

• Daily backup during device engineering
• Final backup following the device commissioning and sign off
• Backup following changes during operation

Upgrades and security configuration

Recommended
action

Defense-in-depth strategy Benefit

Maintenance:
Upgrade and backup

Digitally signed software is used to
help protect the authenticity of the
application binaries.

This security capability helps protect
the authenticity of the application
running on user’s machine.
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Decommission
During decommissioning stage, the following operations are recommended.

Recommended
action

Defense-in-depth strategy Benefit

Decommission • Use Windows OS capability to
uninstall the application.

• Purge application data created
during usage by following
Secure disposal of application,
page 21 section.

These capabilities help prevent the
potential disclosure of data when
the application is decommissioned.

NOTICE
UNINTENDED DATA LOSS OR LOSS OF SOFTWARE FUNCTION
• Only decommission PowerLogic™ Engineering Suite when it is no longer

needed.
• Archive important data and files before decommissioning.
Failure to follow these instructions can result in irreversible damage to
software.

Wipe the application
Wipe the PowerLogic™ Engineering Suite during the decommissioning to help
prevent potential disclosure of data.

Prerequisites:
• Admin rights access privileges.
• Application is not in use.

To wipe the application:
1. Uninstall the application from the operating system application management

panel.
2. Ensure that the application folder in “Program Files” is fully cleared.
3. Delete the application data folder and its content (Program Data).
NOTE: For safety reason, it is recommended to use dedicated software to
ensure the application data are completely deleted and cannot be recovered.

More information about the dedicated software mentioned above, refer to Use a
security tool to completely remove data, page 21 section.

Use a security tool to completely remove data
When you delete a file, the operating system does not really remove the file from
the disk; it only removes the reference of the file from the file system table. The file
remains on the disk until another file is created over it, and even after that, it might
be possible to recover data by studying the magnetic fields on the disk platter
surface. Before the file is overwritten, anyone can easily retrieve it with a disk
maintenance or an undelete utility.

In view of the above-mentioned facts, we strongly recommend you use a security
tool to wipe the data.

We recommend the use of ''Eraser'' (https://eraser.heidi.ie/). It is an advanced
security tool for Windows which allows you to completely remove sensitive data
from your hard drive by overwriting it several times with carefully selected
patterns.

Wiping process:
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1. Access to the DOWNLOAD page to get the latest version of the tool: https://
eraser.heidi.ie/download/

2. Follow the instructions from the Eraser tool (https://eraser.heidi.ie/
selecting-data-to-erase/) to wipe the data from the following two folders:

• Application folder: C:\Program Files\PowerLogic Engineering Suite
• Configuration and communication driver folder: C:\ProgramData

\Schneider Electric\PowerLogic Engineering Suite

3. In addition to the two folders mentioned earlier, we also recommend you wipe
the unused disk space.
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4. Ensure you have selected all the desired files, click OK.

5. From the ask list, right-click the newly created task and select Run Now.

6. After the erase is complete, view the result in the Status column.
If it displays Completed with Errors, the erase was unsuccessful and you
should determine the cause so as to ensure no privacy leaks occur. Once
again, right-click on the affected task and select View Task Log until the
erase is successful.
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Hardening
Hardening is the process of configuring various settings to strengthen security on
connected devices supported by PowerLogic™ Engineering Suite. It involves
password management, access control and disabling all unnecessary protocols
and services.

More information, refer to PowerLogic™ Engineering Suite Cybersecurity -
Windows 10 Hardening Application Note (Document number: PLES
HARDENING/EN AN/ZX.X1).

Hardening PC based solution
Hardening for Windows Operating System is applied following these
recommendations:

• follow security benchmark (CIS)
• define internal firewall rules
• define Services used
• use HIPS (Host Intrusion Prevention System) - Whitelisting
• use antivirus protection for engineering workstation only
• use hardening file system management
• remove remote management privileges
• apply systematic patch management
• apply methods of least privilege applied to applications and user accounts
• respect strong password management
• respect user account management
• removing unused / potential dangerous software
• security system monitoring

Hardening network infrastructure
Hardening applies to routers, firewalls, switches and other devices on the network.

Examples of the hardening activities, tools, and methods include:
• password management including encryption
• disabling of unused services
• access control
• patches, hot fixes, application updates
• strong authentication
• use of secure protocol (SSH V2, HTTPS)
• security system Log (Syslog)

Ethernet switch port access: A malicious user who has physical access to an
unsecured port on a network switch could plug into the network behind the firewall
to defeat its incoming filtering protection.

The following hardening methods can help to mitigate vulnerabilities:
• disable unused ports
• lock specific MAC addresses to specific ports on the ethernet switch
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• lock specific IP addresses to specific ports on the ethernet switch

Password management guidelines
Passwords are often neglected in industrial control systems. Policies and
procedures on password management are often inadequate or missing entirely.

The list proposes generic recommendations for Password management.

Password
coverage

Recommendation

Password
authentication

Enable password authentication, Ethernet interface modules, and embedded
Web servers.

Default
password

Change all default passwords immediately after installation, including those for:
• User and application accounts on Windows, PowerLogic™ Engineering

Suite, HMI and other systems.
• Scripts & source code Network control equipment, devices with user

accounts.
• Grant passwords only to people who need access. Prohibit password

sharing.
• Require users and applications to change passwords regularly (and do not

use the last N passwords) on a scheduled interval.
• Remove employee access account when employment has terminated.
• Require use of different passwords for different accounts, systems and

applications.
• Maintain a secure master list of administrator account passwords so that

they can quickly be accessed in the event of an emergency.
• Implement password management in a way that does not interfere with the

ability of an operator to respond to an event such as an emergency
shutdown.

• Do not transmit passwords via e-mail or in any other way over the insecure
Internet.
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Install and upgrade
Use the information provided in this section to install or upgrade the PowerLogic™

Engineering Suite.

System requirements

System configuration Minimum Recommended

Operating system Windows 10 Pro (64 bits) Windows 10 Pro (64 bits)

Processor clock 1 GHz > 1 GHz

Free storage 1 GB 2 GB

RAM 8 GB 16 GB

Screen resolution 1366 x 768 (HD) 1920 x 1080 (Full HD)

NOTE: macOS is not supported with the PowerLogic™ Engineering Suite.

Installing PowerLogic™ Engineering Suite
To install the PowerLogic™ Engineering Suite:

1. Double-click the PowerLogic Engineering Suite Setup.exe to open the
installation screen.

2. Select the language option for your PowerLogic™ Engineering Suite.
3. Accept the End User License Agreement (EULA) and click Next.
4. On Customer Information page, enter your information and click Next.
5. Under Device Support node, select your desired device series and click
Next.

6. Confirm the component to install and click Next.
7. (Optional) Confirm the installation of the device driver to connect the devices.
8. Wait the installation process.
9. When the installation is complete, a confirmation page will open.

Click Finish to close the installation.

Installing digital certificate
PowerLogic™ Engineering Suite uses client and server communication. To ensure
the privacy and integrity of data transmission, and to prevent unauthorized
access, loss, or theft, the PowerLogic™ Engineering Suite mandates the user's
acceptance of Schneider Electric's digital certificates. The following digital
certificates are required to be installed by Windows™ operating system:

• for “Cybersecurity Admin Expert - Web Server”,
• for “Power Logic Engineering Suite - Web Server”.
Prerequisite: You have installed the PowerLogic™ Engineering Suite and never
launched it on your computer.

1. Launch the PowerLogic™ Engineering Suite application.
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2. From the pop-up Security Warning page, click Yes.

3. Then from another pop-up Security Warning page, click Yes.

4. Close and restart the PowerLogic™ Engineering Suite for further operation.
NOTE:

• Click No to one of the two dialogs will block the launch of the application
on the machine. Nevertheless, the next launch of the application allows to
accept the digital certificate.

• Digital certificate approvals are valid for the login user only (Windows™

account).
Any user who registers on the same computer must follow previous
procedures.

• Schneider Electric digital certificates are valid for one year.
After the expiration date, digital certificate will be automatically renewed,
and the same procedure must be followed.
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First login

WARNING
POTENTIAL COMPROMISE OF SYSTEM AVAILABILITY, INTEGRITY, AND
CONFIDENTIALITY

Change default passwords to help prevent unauthorized access to device
settings and information.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Cybersecurity policies that govern user accounts and access, such as least
privilege and separation of duties, vary from site to site. Work with the facility IT
System Administrator to ensure that user access adheres to the site-specific
cybersecurity policies.

NOTICE
UNINTENDED OPERATION
• Follow operations and recommendations in the hardening guide to help

secure the system.
• General procedures must be respected for nominal installations and

operations.
Failure to follow these instructions can result in irreparable damage.

Application administration account must be changed after the first launch and
login. The first time you log in, PowerLogic™ Engineering Suite will prompt you to
change the default password.

Strong password criteria: A password must have at least 8 characters and
contain at least one character from each of the following:

• uppercase letters
• lowercase letters
• numbers
• special characters.

For more detailed information, refer to Changing the default password, page 16
section.

Upgrading PowerLogic™ Engineering Suite
To stay up to date with the latest features, including cybersecurity updates, we
recommend you upgrade to the latest version.

To upgrade the PowerLogic™ Engineering Suite:
1. In Windows Control Panel window, select Uninstall a program.

The pop-up page displays all the programs installed in current computer.
2. Right-click PowerLogic Engineering Suite program, select Uninstall option

from the pop-up menu.

3. When the uninstallation process is complete, you see a confirmation page.
Click Finish to close the page.

4. Next, extract the latest installer program.
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5. Double-click the PowerLogic Engineering Suite Setup.exe to open the
installation screen.

6. Accept the license agreement and follow the pages of the installation, using
the default settings where possible.

7. When installation is completed, a confirmation page opens. Click Finish to
close the installation.
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Getting started with PowerLogic™ Engineering Suite
This section introduces the overall layout and module descriptions of the home
page to help you quick get started with PowerLogic™ Engineering Suite.

This section is organized by how to login the PowerLogic™ Engineering Suite,
home menu, Get started panel, connect to a device by wire connection or the
network, user preference setting and system localization setting.

Use the information in the following table to find the content you are looking for:

Main modules:

Module Description

PowerLogic™

Engineering Suite
login and access,
page 30

Provides information on how to login the PowerLogic™ Engineering Suite.

Home page and
Home menu, page
31

Provides instructions for About page, Help page and Modules and
License page.

Creating new project
by wire connection,
page 32

Provides two methods for wire connection: by local USB port or by Ethernet
port.

Discovering
networked devices,
page 33

Provides specific procedures to explain how to discover networked devices.

Setting preferences,
page 34

Provides optional preferences, such as: application theme, IEC 61850
display mode, inline guidance, primary value display, restricted parameter
editing, device records folder.

System localization,
page 38

Provides instructions for language support and preference setting.

PowerLogic™ Engineering Suite login and access
1. In the Windows Start menu, select the program entry for the PowerLogic™

Engineering Suite.
The pop-up page displays a warning message.

2. Click Continue to acknowledge the warning message and open the
PowerLogic™ Engineering Suite.
Or click Cancel and Close to exit the application.

3. From the login view, enter your username and password.
NOTE: If you have forgotten your password, seek the assistance from the
Application Administration to help you reset the password.

4. Click LOGIN.
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NOTE: There is a timeout mechanism for PowerLogic™ Engineering Suite, the
default inactivity timeout is 15 minutes. To unlock the session you must enter
the login credentials.

The Home page and Home menu
The following figures show two examples of the Home page of the PowerLogic™

Engineering Suite user interface.

A Main header bar Provides the overview information and navigation function of the
PowerLogic™ Engineering Suite.

B User info menu Provides the user with login information. You can change the
display language and custom preference by selecting the drop-
down menu.

C Home icon Provides the shortcut to the Home Menu.

D Home menu Provides the current software version, supported modules,
licenses and online help of the PowerLogic™ Engineering Suite.

E Get started panel Allows to quickly configure a single device or multiple devices,
and create a project entry.

A

C B

D

E

Peer to peer connection to a device

Add project file

G

H

I
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F Project list Displays the list of projects created by the logged-in user.

G Site list Displays the list of sites if your project has created two or more
sites.

H Site name Displays the specific site name you created.

I Get site location from
Google Maps

Opens the Google Maps window after you click Get directions.

About page
In Home menu > About page, you can find current application version.

Help page
The PDF version of PowerLogic™ Engineering Suite User Manual can be
downloaded from Home menu > Help page, click Open guide to view the
detailed information.

Modules and Licenses
Click Home menu > Modules and Licenses, you can find the following
information:

• Current version number of the PowerLogic™ Engineering Suite Core
• Licenses

Click Licenses from the Application Core panel, check the licensing
requirements of these applications before using them with PowerLogic™

Engineering Suite.
• Supported device name and version number
• Supported data model number of the devices

Click the Add icon from the Data Models panel, import the required data
model if you need.

Creating new project by wire connection
There are two methods for wire connection: by local USB port or by Ethernet port.

Connecting to a device by USB port

1. Plug the USB port to the front panel port of the device.

2. From the Get started panel of Home page, click Plug in a device.

3. Click Connect.
Authentication required window pops up after the PowerLogic™

Engineering Suite detects the connection.

4. Enter the username and the password.

5. Click Authenticate.
For initial setup, if you are using the default username and password on the
connected device, check the Cybersecurity chapter of connected device
User Manual for instructions.
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6. Click Create Project With The Device.
After a few minutes, the workspace is created successfully.

7. Click Open project.

Connecting to a device by Ethernet port

1. From the Get started panel of the home page, click Connect to devices.

2. Select Ethernet Network from the drop-down list.

3. Select Single Device.

4. (Optional) Configure other options if you need.

5. Click Connect.
Authentication required window pops up after the PowerLogic™

Engineering Suite detects the connection.

6. Enter the username and the password.

7. Click Authenticate.

8. Click Create Project With The Device.
After a few minutes, the workspace is created successfully.

9. Click Open project when the process is complete.

Discovering networked devices
1. From the Get started panel of the Home page, click Discover devices.
2. Click Scan to search the devices.
3. No device was found information displays if no devices were found. Click
Scan again to try again.
When the device is found, the name, device type, network type, IP address,
details, and firmware version information are displayed in a single row.

4. Click Connect.
Authentication required window pops up after the PowerLogic™

Engineering Suite detects the connection.
5. Enter your username and the password.
6. Click Authenticate.

If the username and password are correct, a message displaying
Connection successful along with the device name and product name
appears.
If the username or password is incorrect, an error message will appear.

7. Click Create Project With The Device.
After a few minutes, the workspace is created successfully.

8. Click Open project when the process is complete.
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Setting preference
User preferences page is used to tailor your device platform options and the
PowerLogic™ Engineering Suite application options. To access User preferences
page, click the drop-down menu of user identity. Options available to support as
follows:

• Application theme
• IEC 61850 display mode
• Inline guidance
• Primary value display
• Restricted parameter editing
• Device records folder

Application theme
PowerLogic™ Engineering Suite offers three themes to accommodate your
preference.

Theme Description

Auto When you select Auto, the application will adjust to the settings on your computer.

Light Light theme is selected by default during the initial installation.

Dark When you select Dark, the application background turns black.

To set the application theme:
1. Open the drop-down menu by selecting user identity.
2. Click User preferences.

NOTE: The menu varies between the administrator role and other roles.
3. Under General, select Auto, Light or Dark from Application theme drop-

down menu.

4. Click Save to apply the new setting.
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IEC 61850 display mode
The routing matrices support two views.

• The Standard display mode (by default) shows a limited set of the most
commonly used signals and inputs.

• The IEC 61850 display mode shows the IEC 61850 signal name, data type, or
any other relevant information.

To set the IEC 61850 display mode:
1. Open the drop-down menu by selecting user identity.
2. Click User preferences.

NOTE: The menu varies between the administrator role and other roles.
3. Under IEC 61850, turn on Use IEC 61850 display mode by default to

display the IEC 61850 view.

4. Click Save to apply the new settings.
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Inline guidance display
Inline guidance displays additional tips or contextual information in the Device
view to help you understand the current operation page.

Here is an example to show the effect after enabling Inline guidance. When you
disable Inline guidance, the help information surrounded by a red rectangle will be
hidden.

To enable inline guidance:
1. Open the drop-down menu by selecting user identity.
2. Click User preferences.

NOTE: The menu varies between the administrator role and other roles.
3. Under Show inline guidance, turn on Show inline guidance to display the

inline guidance.

4. Click Save to apply the new setting.
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Primary value display
By default, the "per unit" value is displayed without any unit, when primary value is
enabled, the value will be displayed using the appropriate multiplier and given unit.

The left half of the following figure shows the display when primary value mode is
enabled, the right half of the following figure shows the primary value disappearing
when this function is disabled.

To display primary value:
1. Open the drop-down menu by selecting user identity.
2. Click User preferences.

NOTE: The menu varies between the administrator role and other roles.
3. Under Value display mode, turn on Primary value to display the primary

value.

4. Click Save to apply the new setting.
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Device records folder path
To set device records folder path:

1. Open the drop-down menu by selecting user identity.
2. Click User preferences.

NOTE: The menu varies between the administrator role and other roles.
3. Under Device records folder, click Browse.
4. Select the desired stored folder path.
5. Click Save to apply the new setting.

System localization setting
By default, the display language of the PowerLogic™ Engineering Suite is English.

To change the display language of the PowerLogic™ Engineering Suite:
1. Open the drop-down menu by selecting user identity.
2. Click your desired language option.
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Working with projects
This section provides information on creating a project, editing a project, deleting a
project and working with projects in PowerLogic™ Engineering Suite.

What is a project
The PowerLogic™ Engineering Suite manages all the components and data
associated with a site in relation to the project. A project contains at least one site.
Sites, topology, devices, settings values, communication settings and process
data are grouped together and saved in a project.

Project management
Through the project list on the Home page, you can quickly find the target project
by the unique project name.

To create a project, page 39, click Create project from Get started panel on the
Home page.

To edit a project, page 43 or delete a project, page 44, click the Project menu icon
.

Creating a project
This section describes the procedures of creating a project, how to add devices
with different options and how to manage the project information.

1. From the Get started panel of Home page, click Create project.
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2. General information page, enter the information for your new project and
site:

a. In Project information column, enter the project name and description.

Item Supported
character

Minimum number
of characters

Maximum number
of characters

Project name UTF-82 and
Unicode3

characters

1 64

Description for
project

UTF-8 and Unicode
characters

0 256

NOTE: Avoid starting with a space.
b. In Site information column, enter the site name, description, contact

and location.

Item Supported
character

Minimum number
of characters

Maximum number
of characters

Site name UTF-8 and Unicode
characters

1 64

Description for site UTF-8 and Unicode
characters

0 256

NOTE: Avoid starting with a space.
It is recommended to fill out all of the fields. After creating a project, the
location, GPS coordinates (latitude and longitude), contact and phone
information will appear on Home page.

c. In the Picture column, select a picture for the main site.
d. Click Next.
NOTE:

• Red star * indicates the field is mandatory to fill in.
• You can create additional sites after setting up the project and the

site.
3. Add devices to the project page, select one of the following options and

click Next.
• Choose from catalog, page 41
• Import from files, page 41

4. Enter the device name, description, IP address, Subnet mask.
NOTE:

• Forbidden characters for the device name: " < > | : * ? \ /
• Unique device name within a project
• Avoid starting with a dot or a space

5. Summary page, click Create.
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6. Click Open project.

Adding devices from catalog
1. Open Create project dialog.
2. In the Devices step, click Choose from catalog.
Add devices dialog displays the types of devices to be selected.

Browsing the catalog

1. Select a device series in Add devices dialog.
2. Click device type.
3. Select a device in the Catalog section and click Add.

The device displays in the Devices to add column.
4. Enter the number of the selected device.

To remove added devices, click the Delete icon .
5. Click Add devices to finish adding the device model.

Filtering devices

You can enter keywords in the search box to filter device model you need. If the
device model is supported in the current version, the filtered device will be listed in
the Catalog section.

Adding custom devices

1. Click device type in the Custom section.
The Create custom device dialog appears.

2. Select the device information in the GENERAL, HARDWARE and
FIRMWARE sections.
The order code changes according to the device information.
The hardware summary lists the number of the hardware modules.

NOTE: If you have the specific order code of the device, copy all the
characters in a .txt document, then click Paste from clipboard, the order
code will be generated below the ORDER CODE area.

3. Click Create to confirm or Cancel to exit.
The newly customized device appears in the Devices to add section.

4. Click Add devices to finish adding custom devices.

Importing files
1. Open Create project dialog box.
2. In the Devices step, click Import from files.
3. From the pop-up Import devices dialog box, select the type of files you want

to import.
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IEC 61850 files

The figure below displays the IEC 61850 workflow in PowerLogic™ Engineering
Suite.

PowerLogic Engineering Suite

System Con�gurator Tools

ICDCID CID CID

SCD

SCD

SSD

IID

1

3

2

B

A

Px Px Px

Round Trip

Devices

Top-Down

Feedback

Bottom-Up

1
PowerLogic™ Engineering Suite can export all IED Capability Description (ICD) files to the
Bottom-Up workflow.

2
Import the PowerLogic™ Engineering Suite using the System Configuration Description
(SCD) file exported from system configuration tool.

3
After importing the SCD files, it is important to export all the Instantiated IED Description (IID)
files back to the system configuration tool to obtain the unique identifier for each device and to
establish a connection between them. This step is mandatory to create the "round trip"
process.

A
The procedure for importing SCD files into PowerLogic™ Engineering Suite and then
exporting IID files back to the system configuration tool.

B
PowerLogic™ Engineering Suite can send or receive Configured IED Description (CID) files
from supported devices.

To import IEC 61850 files:
1. Select the IEC 61850 files.

The right column displays the drop area.
2. Click Browse to select an SCL (System Configuration description Language)

file or drag the SCL file directly to the right column.
The imported SCL file appears at the top of the right column.
The electrical topology, network topology and all devices are displayed in a
list.

3. Click Import.
NOTE: For the current release, the SCL file is limited to the SCD (System
Configuration Description) file only.
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IED files

1. Select the IED files.
2. Click Browse to select archive files with device and settings directly to the

right column.
The imported file appears at the top of the right column.
The electrical topology, network topology and all devices are displayed in a
list.

3. Click Import.

Editing a project

1. From the project list on the Home page, click the Project menu icon .
2. Select Edit project.
3. In the General information step, edit the project name and description in the
Project information column.

4. Click Save.

Exporting a project

1. From the project list on the Home page, click the Project menu icon .

2. Select Export project.

3. (Optional) Enter the export description information.

4. Click Browse to select the desired folder path for the exported project file.

5. Click Next.
After a few seconds, the Export project page appears with asset information.

6. After confirmation, click Export project.
Your project file (ZIP) is located in the directory path.
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Importing a project

1. From the Get started panel of Home page, click Import project.

2. On the Import project page, click Browse to upload the project file.
The project information appears to the right of the current page, along with
the assets.

3. Click Import.

4. On the Import project page, click Next.
After a few seconds, the project import process is complete and Project
created is displayed on the page.

5. Click Open Project.

6. (Optional) Click the site menu icon to edit this site.

7. (Optional) Click Add site to add other sites.

8. Click Projects to return to the Home page.

Deleting a project

1. From the project list on the Home page, click the Project menu icon .
2. Select Delete project.
3. In the confirmation dialog, click Delete to confirm deleting the project with all

assigned sites and devices, or Cancel to exit.
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Working with sites
This section provides information on adding a site to an existing project, editing a
site, deleting a site, visualizing the list of devices with three topologies view and
working with sites in PowerLogic™ Engineering Suite.

What is a site
A site refers to a geographical subdivision within a project. Most projects have
only one site, larger projects have multiple sites.

Site view
The Site view is the central view in the PowerLogic™ Engineering Suite. You can
use the Site view to manage the components and all the data. For a large project,
you can create and manage multiple sites separately.

Overall layout and navigation
The following figures show examples of the components in the Site view of the
PowerLogic™ Engineering Suite user interface:

PLES/EN M/15A 45

Working with sites PowerLogic™ Engineering Suite



A Main header bar Provides the overview information and the navigation function of the
PowerLogic™ Engineering Suite (project name, the current working
site, the project menu and the login username, etc.).

B Device header bar Provides the device information, status, version and the device
menu.

C Diverse device
display panel

Displays the hierarchy of all the devices within the site in various or
customizable arrangements.

D Device view Provides the device configuration and settings.

E Quick access bar Provides the list of devices that are pinned explicitly or in editing.

F Topology bar Provides a selection function for the topology tree.

G Unassigned devices
bar

Provides a list of devices that are excluded from the current
topology.

H Split icon Provides the ability to view devices side by side.

I Pin icon Provides the ability to pin and unpin the devices of interest.

J Topological item Provides the hierarchy of the topology (for example, in the Electrical
topology, substation, voltage level and bay are topological items).

K Add icon Provides the ability to add elements depending on the current
topology and the selected Topological item.
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Switching between sites
NOTE: Only available when more than one site is created or in use.

1. In the Main header bar, click the Site drop-down menu.
2. Select a site.

The Electrical topology of the site appears in the Site-level navigation panel
and the highlighted topological item appears in the Device view.

Site topologies
Each site organizes its devices into three topologies: Electrical topology,
Network topology (with imported SCD only), and Custom topology.

Switching between topologies
1. In the Site-level navigation panel, click the Topology drop-down menu.
2. Select one topology.

The selected topology appears in the Topology bar.

Electrical topology
The Electrical topology view complies with an ordered hierarchy, the first level is
the Substation, followed by Voltage level and Bay level. You can add a device to
any of these levels.

To manually set an electrical topology:
1. Switch to the Electrical topology.

2. To create a substation, click the Add icon .
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3. Select Substation.
4. On the right side of the Substation interface, type a name for the newly added

substation.
5. To create a voltage level, select the required substations that needed to be

associated.
6. Click the Add icon , and then select Voltage level.
7. On the right side of the Voltage level interface, type a name for the newly

added voltage level.
8. To create a bay level, select the desired voltage to be associated.

9. Click the Add icon , and then select Bay.
10. On the right side of Bay level interface, type a name for the newly added bay

level.
11. To create a device at any level, select the desired level to be associated.

12. Click the Add icon , and then select Devices.
13. On the Add devices to the project page, select an option as needed.

NOTE: You can drag and drop a device to any level of the topology items if
you need.

Network topology
The network topology is used to organize the devices that follow the IT network,
essentially determining how the devices are connected to the data network.

To manually set a network topology:
1. Switch to the Network topology.

2. Click the Add icon and select Devices.
3. On the Add devices to the project page, click an option as needed.

Custom topology
Unlike electrical topology and network topology, custom topology has no
predefined structures, you can set free form structures as necessary.

To add a custom folder:
1. Switch to the Custom topology.
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2. Click the Add icon and select Folder.
3. On the right side of the custom folder interface, type a name for the newly

added folder.
To add a device:

1. Switch to the Custom topology.

2. Click the Add icon and select Devices.
3. On the Add devices to the project page, select an option as needed.
NOTE: You can drag and drop a folder or a device into any hierarchy as
needed.

Unassigned devices
Unassigned devices are devices that do not have a specific hierarchy in the
topology locating in the Unassigned devices bar.

To pin unassigned devices to the Quick access bar, double-click the device in the
Unassigned devices bar.

To move unassigned devices to a topological item:
1. Select a device in the Unassigned devices bar.
2. Drag and drop the device to a topological item.

The device appears in the topological item.
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Site management
For a project with only one site, you can see the site name directly in the project
list. The display principle is {Project name} ● {Site name}.

For a project with two or more sites, only the project name appears in the project
list. You can see the specific site names by clicking the project entry (1) and then
navigating to the secondary page (2) as shown below.

1

2

To add a site to an existing project, click the Project menu icon .

To edit a site:
• If the project with only one site, click the Project menu icon .
• If the project with two or more sites, navigate to the secondary page of the

project and then click the Site menu icon .
To delete a site, navigate to the secondary page of the project and then click the
Site menu icon .
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Adding a site to an existing project

1. From the project list in the Home page, click Project menu icon .
2. Select Add site.
3. Create site dialog pops up with the steps to finalize the creation.
4. Site information step lists the information to be entered for the new site.

• Enter the name, description, contact and location in Site information
column.
It is recommended to fill out all of the fields. After creating a site, the
location, GPS coordinates (latitude and longitude), contact and phone
information will appear on page.

• Select a picture for the site in the Picture column.
• Click Next.

5. Devices step displays the options of adding devices to the site.
For more information, refer to Adding devices from catalog, page 41 and
Importing files, page 41 sections.

6. Summary step lists the site information and devices to be added.
• Click Create.

Creation steps with progress information display in the right column.
Site created information shows after the creation is successful.

7. Click Close.

Editing site information
For only one site in a project:

1. From the project list on the Home page, click Project menu icon .
2. Select Edit site.
3. From the General information step, edit the site name, description, contact

and location in Site information column.
4. Select a picture for the site in the Picture column.
5. Click Save.
For several sites in a project:

1. From the project list on the Home page, click the project name.
The sites list of this project displays.

2. Click the Site menu icon .
3. Select Edit site.
4. From the General information step, edit the site name, description, contact

and location in Site information column.
5. Select a picture for the site in the Picture column.
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6. Click Save.

Deleting a site
1. From the project list on the Home page, click the project name.

The site list of this project displays.

2. Click the Site menu icon .
3. Select Delete site.
4. From the confirmation dialog, click Delete to confirm deleting the site with all

devices or Cancel to exit.

Getting location to your site
If you entered the GPS coordinates for your site location, PowerLogic™

Engineering Suite can offer you the “Get directions” function.

To get the exact location of your site:
1. From the project list on Home page, select your desired site and click Get
directions.

2. Your site's location appears in a new Google Maps popup. Click View on the
header bar to see more details about the location.
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Working with devices
This section introduces the overall layout of the device view, the functions of the
device header bar, and lists some common functions in the setting view of the
PowerLogic™ Engineering Suite.

Device view
The device view is contextual to the device selected in the site-level navigation
panel. Device configuration is primarily performed in the device view, which
contains three components: Device header bar, Setting Table of Content (TOC)
and Setting view.

Overall layout and navigation
The following figure shows an example of the components in the Device view of
the PowerLogic™ Engineering Suite user interface:

A Device header bar Displays the current connection status of the device.

B Setting Table of Content Lists the device settings and configuration logically according to
engineering practices.

C Setting view Provides the editing area of the device.

Device header bar
Device header bar displays the following information:

• Connection status
• Synchronization status
• Synchronize settings between device and application
• Login level
• Device running mode
• Device health overall status
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A Device menu icon Provides the device related actions, such as Export to ICD file,
Save all changes, Connect to device, etc.

B Connection status Displays the current connection status of the device.

Connected status: the icon is green;

Disconnected status: the icon is gray.

C Sync status Provides the current synchronization status of the device and
PowerLogic™ Engineering Suite. There are three statuses:

• Synched
• Unsynched
• Partially synched

D Save Working Copy Provides the function of saving all changes.

E Create new version
drop-down

Creates a version from the current parameter values in the
working copy.

F Synchronize
parameter button

Provides a function for synchronizing settings between device to
database, as well as reversing this process.

WARNING
LOSS OF PROTECTIVE FUNCTION DURING
SETTING CHANGES
• Following a setting change, the relay could

reboot and equipment protection is unavailable.
Ensure all operators are outside the arc flash
boundary during device reboot.

• Use appropriate personal protection equipment
(PPE) while making setting changes within the
arc flash boundary.

• Do not approach the equipment until the device
reboot is complete.

Failure to follow these instructions can result
in death, serious injury, or equipment damage.

G Expand window Zooms the Device view into full screen and restore its original size
when clicked again.

H Login level Displays the cybersecurity role for the connected user. There are
four roles defined by the RBAC:

• Application administrator
• Installer
• Engineer
• Operator

I Device running mode Provides Normal and Safe two modes.

J Device health overall
status Provides Ok ,Warning , Alarm three health status

displays.

K Incompatible warning
icon

When the device does not match the settings in PowerLogic™

Engineering Suite, this warning icon appears.
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Focus mode
1. In the Setting Table of Content, select a setting topic.

2. From the Device header bar, click the Focus mode icon .
The Main header bar and Site-level navigation panel are hidden.

3. Click the Focus mode icon again.
The window returns to the Site view.

Table of content for device settings

A Searching bar Provides a searching bar to quickly search topics.
NOTE: The search mechanism is case-sensitive, which
means "Overcurrent" and "overcurrent" are treated as
distinct search terms.

B Chapter Displays the first level of content, grouping content at a high
level. Only one chapter is displayed at a time.

C Group Displays the second level of content.

D Setting Displays the last level of content.

E Expand all Displays all the settings.

Searching in TOC
You can quickly find desired Setting page by using the searching bar at the top of
the Setting TOC.

To search one Setting page:
1. In the device view, click in the searching bar at the top of the Setting TOC.
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2. Type your desired characters.
Content appears based on the search criteria you entered. Note that
characters are case sensitive.

3. Select the desired topic from the returned results to open the setting page.

TIP: To close the search input in searching bar, click the icon or click the
Expand all on the bottom right of the Setting TOC.

Editing and saving settings
NOTE: The screenshots are only meant to show the effect of certain
operations and may not work on all supported devices.

1. Select a basic setting topic in the Setting Table of Content.
The details of the setting display in the Setting view.

2. Click one of the settings in the Setting view.
The editing box is framed with a blue border.
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3. Edit the setting.
The background of edit box changes to blue and a blue bullet appears in the
Setting Table of Content.

NOTE: The icon indicates the device needs to be rebooted when the
setting is changed.

4. Click Save Working Copy.

Device management
This section provides an overview of regular tasks related to device management,
covers the procedures for displaying two device setting views in parallel, pinning
devices, exporting device configuration, exporting an ICD file, connecting a
device, and version control.

Through the project listed on the Home page, you can easily determine how many
devices are managed within the parent project.

Take the above screenshot as an example, My Projectmanages two devices,
while Project A manages one device.

Displaying devices side-by-side

When you set more than two devices in the Quick access area, a split icon
displays.

To display devices side-by-side:
1. Select one device which you need to display it on left side.

2. Click Split icon .
You will find devices display side-by-side.

Click the icon to cancel displaying devices side-by-side.
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Renaming a device

1. In Diverse Device Display Panel, right-click the device name you want to
rename and then select Rename.

2. Enter desired new name.

Deleting a device

1. In Diverse Device Display Panel, right-click the device name you want to
delete and then select Delete. This opens the Delete Device confirmation
dialog.

2. In the confirmation dialog box, click OK.
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Pinning a device
In Diverse Device Display Panel, the default Quick access bar is empty.

To pin a device, there are three methods:

Method 1: Double-click the device you want to pin, then you will find the device is
in Quick access bar.

Method 2: Select the device you want to pin and drag to the Quick access bar.

Method 3: Right-select the device you want to pin and select Pin in the context
menu.

To unpin a device:

From the Quick access bar, click the Pin icon beside a device.
The device is removed from Quick access bar.

Exporting device configuration

1. Click the menu next to the device name.
2. From the drop-down list, select Export device configuration option.
3. Select a destination to export the device configuration file.
4. If operation success, Operation success displays in Export device
configuration window.
Click Close to quit this window.

If operation failed, click Show Logs for details.
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Exporting to ICD SCL file
Before exporting to ICD SCL file, save current settings.

1. Click the menu next to the device name.
2. From the drop-down list, select Export to ICD SCL file option.
3. Fill out the version information and description fields.

NOTE: Mandatory inputs are highlighted with a red star *.
4. Enter change description if you need.
5. Browse to select a destination for the ICD file.
6. Click Export to begin the export process.
7. Click Close to close the window.

Exporting to IID SCL file
NOTE: Before exporting to IID SCL file, save current settings.

1. Click the menu next to the device name.
2. From the drop-down list, select Export to IID SCL file option.
3. Fill out the Version Information area (mandatory field), and enter your

change description if needed.
4. Browse to select a destination for the IID file.
5. Click Export to begin the export process.
6. Click Close to close the window.

Connecting to the device
There are two ways to connect to the device:

• by manual configuration
• by scanning the network

Physical device compatibility checks
If the physical device capabilities are not compatible with the local configuration,
you will see a dialog to notify the connection issues when connecting to the
device.

Following check items may be performed in system background, the specific
check items depend on the device.

• Serial number
• Application
• License
• Firmware version
• Hardware
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Connecting to device by manual configuration

1. Click the menu next to the device name.
2. Select Connect to device option.
3. From the pop-up Connect to device dialog box, select the check box of
Manual configuration.

4. Define the Connection settings.
5. Click Connect.

The Authentication required dialog box requires for the username and
password.

6. Enter the username and password of the device.
7. Click Authenticate.

• If connection is successful, system pops with Connection information
and comparison screen, click OK to continue, device status displays
Connected.

NOTE: The Connection information and comparison screen may
vary depending on the situation.

• If the physical device capabilities are incompatible with the local
configuration in PowerLogic™ Engineering Suite, an additional dialog or
message is displayed to indicate the reason for the failure.

NOTE: Compatibility issues screen may vary depending on the
situation.

More information about the compatibility checks, refer to Physical device
compatibility checks, page 60 section.

Connecting to device by scanning the network

1. Click the menu next to the device name.
2. Select Connection to device option.
3. From the pop-up Connect to device dialog box, select the check box of
Scan networks.

4. Select the network.
5. Click Scan to search the devices.

• Add connected devices dialog displays or
• No device was found information displays if no device is found. Click
Scan again to restart the search.

6. Click Connect.
The Authentication required dialog requires for the username and
password.

7. Enter the username and password of the device.
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8. Click Authenticate.
• If connection is successful, device status displays Connected.
• If the physical device capabilities are incompatible with local

configuration in PowerLogic™ Engineering Suite, an additional dialog or
message is displayed to indicate the reason for the failure.

More information about the compatibility checks, refer to Physical device
compatibility checks, page 60 section.
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Live data and controls panel
The Live data and controls panel provides you with real-time access to
measurement values, data quality indicators, and statuses. This interface allows
for direct manipulation of measurement parameters, ensuring that you can monitor
and manage connected devices efficiently.

NOTE: The functions on the Live data and controls panel may vary depending
on the connected device.

Measurement value and status value
You can add or remove the following sections as needed. Depending on the
device platform, you may also have the option to select and send commands.

• RMS current measurements • Current measurements

• RMS voltage measurements • Voltage measurements

• Current sequences • Voltage sequences

• Energies • Device information

• Time synchronization • Network connections

• Binary inputs • Binary outputs

• Trip conditioner • Logic outputs

NOTE: The sections mentioned above may vary depending on the services
present on each connected device.

When it comes to analog measurement values, there are often defined ranges.
Measurement values are indicated by icons. If a measurement is within the normal
range, no icon will appear next to it. If it is outside the normal range, one of four
colored icons will display as shown below, representing the measurement status
relative to the defined ranges.
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On hovering, you can see a tooltip displaying the meaning.
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IEC 61850 quality bits display
Using the Live data and Controls panel, you can assess the quality of
measurement data and status data at two different levels. More information, refer
to the table as follows.

NOTE: The IEC 61850 quality bits display on Live data and Controls panel
depends on the services present on each connected device.

Two levels to
display the
quality of data

Data Attribute
(DA)

Display mode Example

Validity Good No icons

No icons displayed in the value fields, indicating that the quality of VA, VB
and VC values is Good.

Invalid Information icon +
Tooltip

A: Test mode icon.

When the connected device is in Test mode, this test mode icon will
appear closely to the signal.

B: Information icon.

You can view the tooltip by hovering the mouse over this information icon

, as follows.

Questionable Information icon +
Tooltip

Quality details Overflow Tooltip

OutOfRange Tooltip

BadReference Tooltip

Oscillatory Tooltip

Failure Tooltip

OldData Tooltip

Inconsistent Tooltip

Inaccurate Tooltip

Source Tooltip

Test Tooltip

OperatorBlocked Tooltip
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Connecting to the device to view live data
1. Select your desired project and site from the home page, go to device setting

view.

2. On the upper-right corner of the setting view, click the icon to expand side
panel.

3. Click Connect to device.

4. Refer to the following sections to complete the connection.
• Connecting to device by manual configuration, page 61 or
• Connecting to device by scanning the network, page 61

5. After connected successfully, click the on the top of the side panel to view
live data of the connected device.
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6. To pause real-time updates, click the .

Version control
Version control can help you track changes made to the setting view over time.
Once the version control function is selected, PowerLogic™ Engineering Suite
takes a snapshot of the files, and then permanently stores that snapshot so the
version can be retrieved later if needed.

Creating a new version
Whenever you want to save the current state of the configuration, you can create
a new version.

1. Click the icon next to the Save Working Copy.

2. Select Create Version.

3. (Optional) In the Create Version window, select the Major number.
Note: By default, the initial version number is 1.0. Whenever a new version is
added, the minor number will automatically increase by 1. That is to say, the
version number will be set to 1.1 for the second new version. If you want to
change the major version number, the minor version number is automatically
reset to 0.

4. (Optional) Enter the description information for current parameter values.
Note: Description information is recommended for future quick searches and
retrieval.

5. Click Create.

After a few seconds, the creation process is complete. You can click the
icon again to see created version information including: created account,
created date and created time.

Searching the previous version
You can search a history version of the settings by the version management
function.

1. Click the icon next to the Save Working Copy.

2. Select Search more.

PLES/EN M/15A 67

Working with devices PowerLogic™ Engineering Suite



3. On the Version management and comparison window, select your desired
version from the version list, or enter the version number or description in the
search bar.

Reverting to the previous version

1. Click the icon next to the Save Working Copy.

2. From the Version history or Click Search more, select a required version.
Note: You will only see the latest three version numbers in the Version
history list. To view complete version numbers, click Search more.

3. Click Revert to switch the working copy.

Viewing version description
You can view the version description information to identify required configuration
version.

1. Click the icon next to the Save Working Copy.

2. Select Search more.
Version management and comparison window pops up.

3. From the list of the version history, view the description field for each version.
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Logging
When the device is operating, it can record some information allowing to
understand either the behavior of the device itself or the controlled equipment by
this device.

Extract logs from the device is based on what the device is able to provide as a
log. Generally, PowerLogic™ Engineering Suite supports the extraction of device
logs, event logs, fault records and disturbance records, varying depend on the
device.

Device records storage path
For PowerLogic™ Engineering Suite debugging, maintenance and activity tracking
purposes, you need to access the storage path of the device records.

By default, the device logs are located in the following directory:
C:\ProgramData\Schneider Electric\PowerLogic Engineering Suite\device-logs

Downloading logs
There are two ways to download logs: downloading logs one by one or batch
downloading.

Downloading logs one by one

1. Click the Save icon to save the log to the database.

2. Click the Download icon to download the file to local server.

3. Repeat step 1 and step 2 to download other required logs.
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4. Go to storage path of the device logs to view the logs.
To know the specific device logs folder, click the drop-down list of User login
menu, then select User preferences to get the storage path of device
records.

Batch downloading

1. Click the Save icon to save the log to the database.

2. Click the Save icon of the next log.

3. Tick the check box for multiple logs.

4. Click Download to batch download selected logs.

5. Go to storage path of the device logs to view the logs.
To know the specific device logs folder, click the drop-down list of User login
menu, then select User preferences to get the storage path of device
records.
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Deleting logs
There are two ways to delete logs: deleting logs one by one or batch deleting.

Deleting logs one by one

1. Click the delete icon in the row of the required log file.

2. Repeat the step 1 to delete another log until task is completed.

Batch deleting

1. Tick the check box for multiple logs.

2. Click Delete all to batch delete selected logs.

Modifying device records folder path
1. Click User info drop-down menu.

2. Select User preferences option.

3. From the pop-up User preferences window, click the Browse beside Device
records folder area.

4. Set the required location, then click Select Folder
You can find the file path has updated as you set.

5. After confirmation, click Save.
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Abbreviations
Abbreviations used in the manual

Acronyms Indication

CIS Center for Internet Security

DNP3 Distributed Network Protocol

DoS Denial of Service

HD High Definition

HIPS Host Intrusion Prevention System

HTTPS Hypertext Transfer Protocol Secure

ICD IED Capability Description

IEC International Electro technical Commission

IEDs Intelligent Electronic Devices

IID Instantiated IED Description

JWT JSON Web Token

MAC Media Access Control

PAC Programmable automation controller

PPE Personal Protection Equipment

RAM Random Access Memory

RBAC Role Based Access Control

SCD System Configuration Description

SCL System Configuration description Language

SOE Sequence of Event

SSH Secure Shell Protocol

TLS Transport Layer Security

TOC Table of Content

VLAN Virtual Local Area Network
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Revision history

Document version Description
PLES/EN M/15A

2024-09

Installing digital
certificate

Newly added section for cybersecurity consideration.

Overview Rephrased this section to make the content more accurate.

Creating a project Added some descriptions based on the support for ASCII
characters and Unicode characters input.

Live data and controls
panel

Renamed this topic to align with current interface design.

Connecting to the
device to display live
data

Updated this topic to align with current control strategy on Live
data and controls panel.

Measurement value
and status value

Added two screenshot to show the different interface design
between two devices.

Updated a screenshot to align with current interface design.

Workflow Added some descriptions to align with the functions of current
live data and controls panel.

IEC 61850 quality bits
display

Updated the screenshots to align with current interface design.

Renaming a device

Deleting a device

Newly added two topics to align with current platform version.

Pinning a device Updated this topic to align with current platform version.

PLES/EN M/14A

2024-07

Live data panel

Measurement value
and status value

IEC 61850 quality bits
display

Connecting to the
device to display live
data

Newly added sections for live data feature.

Searching in TOC Newly added section for searching feature in device view.

Deleting a user Newly added sections for user management feature.

Security capabilities
of PowerLogic™

Engineering Suite

PowerLogic™

Engineering Suite
login and access

Updated the two sections for timeout mechanism.

Changing the
password

Updated this section due to the CAE version 3.2.3 integration.

Disabling a user Updated this section due to the CAE version 3.2.3 integration.

Enabling a user Updated this section due to the CAE version 3.2.3 integration.

Device header bar Updated the explanation for the “Login level”.

Table of content for
device settings

Updated the section to align with the latest feature for this
release.

PLES/EN M/15A 73

Revision history PowerLogic™ Engineering Suite



Document version Description

Exporting to ICD SCD
file

Renamed “Exporting to ICD file” to “Exporting to ICD SCD file”
to align with current UI design.

Creating a project,
page 39

Added two tables and notes for naming convention.(ESCORE-
1076)

Updated the images Used up-to-date screenshots to ensure that they match the
latest release version of PowerLogic™ Engineering Suite.

Release / Build 1.3.0
PLES/EN M/13A

2023-12

Redesigned the
whole manual outline
and refined some
topics.

The new Table of Content can reflect the change.

Purpose of this
manual

Newly added section.

Workflow Newly added section.

Software user manual
version

Newly added section.

Cybersecurity Newly added chapter.

Hardening Newly added chapter.

First login Newly added section.

System localization
setting

Newly added section.

Exporting a project Newly added section.

Importing a project Newly added section.

Electrical topology Newly added section.

Network topology Newly added section.

Custom topology Newly added section.

Abbreviations Newly added chapter.

Modules & Licenses Updated this section to align with the enhancements made to
Modules and Licenses page.

Getting location to
your site

Newly added section.

Searching the
previous version

Newly added section.

IEC 61850 files Updated this section.

Updated the images Used up-to-date images to ensure that they match the latest
release version of PowerLogic™ Engineering Suite.

Release / Build 1.2.0
PLT/EN M/12A

2023-05

Chapter rename Renamed “Install and uninstall” to “Install and upgrade”.
Renamed “Configuring a device” to “Device configuration”.

Chapter content and
image update

Updated “Install and upgrade”, “Getting started”, “Project and
site management”, “Site view”, “Device configuration”,
“Logging” chapters to make procedures and descriptions
harmonized with current application version.

Removed non-generic features which not belong to the
application itself from manual.

Release / Build 1.1.0
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Document version Description
PLT/EN M/11A First edition for initial product release

2022-09 Release / Build 1.0.0
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